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IN THIS TUTORIAL

 1

The cadastral editor introduces a new set of tools for maintaining land 
records in ArcGIS Survey Analyst 9.2  
In this tutorial, you will be introduced to the cadastral fabric dataset. A 
cadastral fabric is a seamless parcel boundary network, which is created 
and maintained using data from survey records. You will create a cadastral 
fabric and migrate some existing parcel-based GIS data from Alachua 
County, Florida, into your cadastral fabric. In the following exercises 
you will edit the cadastral fabric and add new parcel data from the 
Timberbrooke and Edgewood survey plans. 
When adding parcel data from survey plans, you are essentially updating 
your cadastral fabric (boundary network) with new survey measurements. 
The Least Squares Adjustment adjusts the cadastral fabric in response to 
these new measurements and finds a new “best-fit” for all the parcel corners. 
Many geographic information systems use cadastral records to build the 
base map for all other layers in the GIS. As the cadastral fabric is adjusted, 
overlying GIS layers will fall out of alignment with the parcel base map. 
In exercise 7, you will run a GIS feature adjustment which applies the 
coordinate shifts resulting from the Least Squares Adjustment to your 
overlaying GIS feature classes. The GIS feature adjustment will bring your 
GIS layers back into alignment with your updated cadastral fabric.

Cadastral Editor Tutorial for Survey Analyst

• Exercise 1: Organizing the tutorial 
data

• Exercise 2: Creating and managing 
a cadastral fabric

• Exercise 3: Creating new parcels 
in fabric jobs

• Exercise 4: Working with parcel 
construction tools

• Exercise 5: Appending groups of 
parcels to the cadastral fabric

 
• Exercise 6: Adding control points 

to your cadastral fabric

• Exercise 7: Adjusting your 
cadastral fabric using the Least-
Squares Adjustment

 

Beta 3
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To work with this tutorial, you will need to have the ArcGIS 
Survey Analyst extension installed. Before you can begin 
the tutorial, you must find and organize the data you will be 
working with. Using ArcCatalog, browse for and create a 
new folder connection to your data:
1. Click the start menu, point to Programs, point to 

ArcGIS and click ArcCatalog. 
2. Navigate to the location of the tutorial (the default path 

is \arcgis\ArcTutor on the drive where you have ArcGIS 
installed).

3. Select the Cadastral Editor folder and copy the folder to 
your local drive.

The tutorial data is now copied to your local drive.

Connecting directly to your tutorial data

Folder connections in ArcCatalog simplify the task of 
navigating to your most frequently used datasets.
1. On the Standard toolbar in ArcCatalog, click Connect to  

Folder 
2. In the Connect to Folder dialog, navigate to and select 

your local copy of the Cadastral Editor tutorial folder.
3.  Click OK.
Your new folder connection is now listed in the Catalog 
tree. You will now be able to access all the data needed for 
this tutorial through this connection.

Exercise 1: Organizing the tutorial data

The Survey Editor and the Cadastral Editor appear as child 
nodes under the Survey Analyst extension.
4. Click Close.
The Survey Analyst extension is now enabled.

Enabling the Survey Analyst Extension

Before you can begin working with the cadastral editor, you 
need to enable the Survey Analyst extension:
1. In ArcCatalog, click the Tools menu on the Main Menu 

toolbar. 
2. Click Extensions... 
3. Check the Survey Analyst checkbox in the Extensions 

dialog.
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Exercise 2: Creating and managing a cadastral fabric

In this exercise, you will create a new cadastral fabric 
dataset. Most cadastral fabrics will use, as a starting point, 
existing parcel data from GIS and CAD layers. You will 
migrate existing parcel-based GIS data from Alachua 
county into your cadastral fabric. Later on in the exercise, 
you will load the cadastral fabric dataset as a layer into 
ArcMap.

Creating a new cadastral fabric dataset

Cadastral fabric datasets are created as new nodes under 
feature datasets in ArcCatalog:
1. In ArcCatalog, click the plus sign next to your new 

cadastral editor folder connection. Click the plus sign 
next to the TutorialData folder to expand its contents. 
Click the plus sign to expand the AlachuaCounty 
geodatabase.

 
2. Right-click the ACPA feature dataset, point to new and 

click Cadastral Fabric...

The New Cadastral Fabric Wizard appears.

3. Accept the default cadastral fabric name of “New 
Fabric”. Click Next.

4. Click Finish on the New Cadastral Fabric summary 
page to create your cadastral fabric.
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A new cadastral fabric dataset called “NewFabric” appears 
as a new node under the ACPA feature dataset.

Migrating data into the cadastral fabric

To migrate parcel-based GIS data successfully into a 
cadastral fabric, the GIS feature classes need to be aware 
of the cadastral fabric data model. Cadastral fabric parcel 
polygons are comprised of a set of lines, which have 
two end points. The cadastral fabric has its own internal 
arc-node topology. Any GIS data being migrated into a 
cadastral fabric needs to have arc-node topology. Parcel 
lines need to be aware of their common endpoints, and of 
their left and right parcel polygons.
1. Double-click the ACPA feature dataset in the 

AlachuaCounty geodatabase to expand its contents.
There are three parcel-based feature classes: 
AlachuaCounty_arc,  alachuaCounty_node and 
alachuaCounty_polygon.

The AlachuaCounty_arc feature class defines the parcel 
lines that make up the parcel polygons, the alachuaCounty_
node feature class defines the common end-points of the 
parcel lines (parcel corners) and the alachuaCounty_
polygon feature class defines the parcel polygons.
You will now migrate the GIS parcel-based feature classes 
into your cadastral fabric:
3. Click on the Contents tab in the right-hand pane to 

switch out of preview mode in ArcCatalog.
4. Right-click the cadastral fabric dataset you just created 

under the ACPA feature dataset. Point to Import and 
click Fabric Data.

2. Select each feature class and click the Preview tab in 
the right-hand pane to view the features.

The Import Fabric Data wizard appears.
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By default, the Import Fabric Data wizard automatically 
searches for parcel-based GIS feature classes in the feature 
dataset in which the cadastral fabric was created. The 
Import Fabric Data wizard has located your parcel-based 
GIS feature classes in your ACPA feature dataset.
5. If you want to locate your fabric source data, click the 

open file button  to locate the GIS feature classes 
in the ACPA feature dataset.

6. In the Select a feature dataset dialog, navigate to ACPA 
feature dataset in the AlachuaCounty geodatabase in 
your cadastral editor\tutorialdata folder. Select the 
AlachuaCounty_arc feature class.

Since all three fabric source feature classes are named the 
same, you just need to select one fabric source feature class 
and the importer will identify the remaining two fabric 
source feature classes.

Fabric source GIS feature classes should all have the same 
name. The parcel lines feature class should be underscored 
with “_arc”, the parcel polygon feature class should be 
underscored “_polygon” and the parcel node feature class 
should be underscored “_node”.
7. Click Next on the Import Fabric Data Wizard.
In the next step of the importer, you need to specify the 
measurement units of the COGO attributes of your fabric 
source data. Note that your fabric source data does not 
necessarily need COGO attributes. If your data has none, 
the dimension data will be inversed and generated from the 
shape fields of the fabric source feature classes.
8. Make sure Degrees Minutes and Seconds is selected for 

Direction and angle units and that Quadrant Bearing is 
selected for Direction type. 

Note that distance units are inherited from the spatial 
reference of the fabric source feature classes.
9. Click Next.
Now you will set some data migration tolerances for your 
fabric source data:



6

Survey Analyst - Cadastral Editor Tutorial Beta 3

10. Enter 5 feet for the Radial point tolerance. Radial 
point tolerance is the maximum amount by which 
two successive curve radii can vary, for them to be 
considered the same radius with the same center point.

Accept the default for the Link to control tolerance. You 
need to Enter a Control point match tolerance if you have 
already imported control points into your cadastral fabric 
before your fabric source parcel data. You will import 
control points in a later exercise.
11. For inversed line accuracy category, leave the default 

as 6. If your fabric source data has no COGO attributes, 
the dimension data will be inversed from the shape field 
of the line feature class. These imported parcel lines in 
the cadastral fabric are given a low accuracy category 
of 6.

12. Click Next to view the data migration summary.
13. Click Finish to start the data migration process.
14. Once the data migration has completed, click the 

Preview tab on the right-hand pane in ArcCatalog to 
preview the data in your cadastral fabric.

Managing your cadastral fabric

The internal tables and feature classes that make up a 
cadastral fabric behave just like normal feature classes 
in ArcCatalog. You can add attributes to, and create 
relationship classes with, fabric classes and tables. You can 
also add subtypes and domains. 
You will now create a relationship class between the 
cadastral fabric and the parcel ownership data for Alachua 
county.
1. Right-click the ACPA feature dataset, point to New and 

click Relationship Class...
The New Relationship Class wizard will appear.
2. Type in “FabricParcels_Owners for the name of the 

relationship class.
3. For the origin feature class, expand the ACPA feature 

dataset and select NewFabric_Parcels. For the 
destination table, select Alachua_Owners.
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4. Click Next.
5. For the relationship type, keep Simple (peer to peer) 

relationship selected.
You will notice that the Composite relationship option 
is greyed out. This is because a cadastral fabric cannot 
participate in a composite relationship, where data in a 
cadastral fabric table could be altered and corrupted by 
changes in the related table. 
6. Click Next.
7. Accept the default labeling and message propagation 

settings and click Next.

8. Click 1-M (One to Many) for the cardinality of the 
relationship class (one parcel can have many owners). 
Traditionally, you would define a M-N (Many-Many) 
relationship between parcels and owners, but for 
the purposes of this tutorial, you will define a 1-M 
relationship.  

9. Choose not to add any attributes to the relationship 
class and keep the default setting selected. Click Next.

10. Click the drop-down list for the primary key in the 
origin feature class (NewFabric_Parcels) and select 
“Name”. 

11. Click the drop-down list for the foreign key in the 
destination table (Alachua_Owners) and select “ID”.

 
12. Click Next to view the relationship class summary.
13. Click Finish.
The new FabricParcels_Owners relationship class appears 
under the ACPA feature dataset.
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Associating GIS feature classes to your cadastral 
fabric

When you run a Least Squares Adjustment on your 
cadastral fabric, new coordinates are computed for the 
parcel corner points. Parcels in the cadastral fabric will 
thus adjust over time. GIS features classes that use parcel 
boundaries as a basemap, will fall out of alignment with 
the adjusted parcel boundaries . The cadastral editor 
captures the shifts between the old and new coordinates 
of the adjusted parcel corners and stores these shifts as 
displacement vectors in a table in the geodatabase. The 
displacement vectors are then applied in the GIS Feature 
Class adjustment to realign the GIS feature classes with the 
adjusted cadastral fabric. To be able to run a GIS feature 
class adjustment on your GIS data, you need to associate 
the feature classes to your cadastral fabric.
1. Right-click your cadastral fabric in the ACPA feature 

dataset and click Properties.

2. In the Cadastral Fabric Properties dialog, click the 
Associations tab.

3. Click the Add button.

 
4. In the Associate Feature Classes dialog, navigate to the 

GRU feature dataset in the AlachuaCounty geodatabase, 
select the Roads and Buildings feature classes and click 
Add.
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Both the Roads and Buildings feature classes are now listed 
as associated feature classes in the Associations dialog. 
Note that the adjustment date for both feature classes is set 
to “Not yet adjusted” until they participate in a GIS Feature 
Class Adjustment. When the feature classes are adjusted in 
a GIS feature class adjustment, the adjustment date will be 
set to the date of the last Least Squares Adjustment run on 
the cadastral fabric (known as the Adjustment Level).
5. Click OK to close the Cadastral Fabric properties dialog 

and apply the changes.

Viewing the cadastral fabric in ArcMap

In this section you will add your cadastral fabric dataset as 
a cadastral fabric layer into ArcMap. The cadastral fabric 
is loaded as a composite layer into ArcMap. The internal 
feature classes that make up the cadastral fabric are sub-
layers under the cadastral fabric composite layer. These 
fabric sublayers can be queried, symbolized and displayed 
just like normal feature class layers in ArcMap. 
1. Close ArcCatalog.

2. Open ArcMap by clicking the Launch ArcMap button 

 on the Standard toolbar in ArcCatalog.
3. In the ArcMap dialog, click Browse for maps and click 

OK. Navigate to the Cadastral Editor tutorial folder on 
your local drive.

If your ArcMap dialog does not appear, click File -> Open 
and navigate to your Cadastral Editor tutorial folder on your 
local drive.
4. Select the AlachuaCounty ArcMap document and click 

Open.
ArcMap displays a map of your cadastral fabric, with the 
roads and buildings GIS feature classes. The cadastral fabric 
composite layer is comprised of the Control, Linepoints, 
Points, Lines and Parcels sublayers. These are the internal 
feature classes that make up the cadastral fabric. The Lines 
sublayer has several line categories, with each category 
representing an internal cadastral fabric line type. The 
radial lines (shown in light grey) are displayed for curved 
boundaries, and they extend out to the center point of each 
curve boundary in the cadastral fabric.
The Linepoints sublayer displays those parcel corner points 
that lie on the boundary lines of their adjacent parcels. 
Linepoints are important in that they do not split the 
adjacent parcel’s boundary line, rather, they “float” on the 
adjacent parcel’s boundary line. In this way, the boundary 
line of the adjacent parcel remains a single boundary line, 
staying true to the survey record, and not two separate 
boundary lines.
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5. Make sure the Survey Analyst - Cadastral Editor 
extension is turned on for ArcMap (Tools -> 
Extensions).

For now, turn the display of the GIS feature classes off. You 
will work with them later:
6. In the table of contents (TOC), uncheck the Buildings 

and Roads GIS feature classes. Save the map document. 
(File -> Save)

You will now use the Identify tool to examine the attributes 
and relationships of a parcel in the cadastral fabric. First, 
you need to zoom in a little closer to the area you will be 
working with:
7. In ArcMap, click the View menu on the Main Menu 

toolbar, point to Bookmarks and click Timberbrooke.

The map display zooms to the extent of the parcels in the 
Timberbrooke survey plan.

8. Click the Identify tool  on the Tools toolbar. (If 
the Tools toolbar is not present, Click View, point to 
Toolbars and click Tools.)

9. Using the Identify tool, click on a parcel that has 
LinePoints in the map extent.

The Identify dialog displays the attributes of the parcel you 
selected.

10. Make sure NewFabric parcels are selected in the 
Identify from drop down list.
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11. Click the plus sign next to the parcel PIN.
The parcel’s related lines, plan information and accuracy 
information appear. The related parcel ownership 
information (Alachua_Owners) is also displayed. This is 
from the relationship class you created earlier.

12. Click the plus sign next to Lines to view the parcel lines 
that make up the parcel polygon. 

The parcel lines store the survey record information. Each 
parcel line stores dimension information, which comes from 
the associated record of survey, for example, the survey 
plan.
13. Click on each parcel line to view its attributes. The 

parcel line will also flash green in the map extent.
You will notice that the selected parcel line in the 
screenshot below is not split by the adjacent parcel corner 
point lying on the line. This is because there is a line point 
defined on the adjacent parcel corner point.
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14. Click the plus sign next to one of the parcel lines.
The To and From points of the parcel line are displayed 
in the Identify dialog. The parcel line’s associated 
accuracy information is also displayed. Parcel lines in the 
Timberbrooke survey plan have an accuracy level of 2.

15. Click the plus sign next to Alachua_Owners to view the 
ownership information for the identified parcel.

16. Click the plus sign next to Plans to view the parcel’s 
associated plan or record of survey information.

Since the parcel data was migrated, only the Plan name 
information is displayed. Later on, you will populate the 
remaining plan attributes.
17. Close the Identify dialog to complete Exercise 2.
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Exercise 3: Creating new parcels in fabric jobs

In this exercise you will add a new parcel to the cadastral 
fabric using a parcel traverse. The new parcel is part of 
the Timberbrooke survey plan. Whenever you edit your 
cadastral fabric, you need to select and extract the parcels 
you are working with, out into a fabric job. Fabric jobs are 
created automatically for you during the extraction process. 
You can also manually create and customize a fabric job, 
and provide a job title, operator and a job description. You 
will customize a fabric job in a later exercise.

Modifying parcels in the cadastral fabric

You will be working with parcels from the Timberbrooke 
survey plan. To view this plan, open the Timberbrooke PDF 
file in your Cadastral Editor\TutorialData\ folder on your 
local drive. You will need Adobe Reader to view this file.
1. If ArcMap is not open, restart ArcMap and open the 

AlachuaCounty map document.
2. Zoom to the extent of the Timberbrooke survey plan 

(View -> Bookmarks -> Timberbrooke).
Make sure that the Editor and Cadastral Editor toolbars are 
loaded in ArcMap:
4. Click the View menu on the Main Menu toolbar, point 

to Toolbars and click Cadastral Editor. Do the same for 
the Editor toolbar.

5. Click the Editor menu on the Editor toolbar and click 
Start Editing to start an edit session.

You will now select the parcels you will be working with 
and extract them out into a fabric job:

6. Click the Select Cadastral Features tool  on the 
Fabric Editing toolbar.

7. On the map display, drag a box around the parcels in 
the area of the Timberbrooke survey plan.

8. Click the Cadastral Editor menu on the Cadastral Editor 
toolbar and click Modify...
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The selected parcels are extracted out to a fabric job and 
the fabric job is automatically created in the background. 
The cadastral fabric is now displayed in fabric job mode: 
The parcels that are part of the fabric job are displayed as 
active and are available for editing. The parcels outside of 
the fabric job are displayed as inactive and are not available 
for editing.
A docked Parcel Explorer window is also displayed on the 
map, as well as a docked Parcel Properties window.

The Parcel Explorer lists all the active parcels in the open 
fabric job by their associated survey plan. In the fabric 
job you just created, there are parcels from the Hazel 
Heights survey plan, the Timberbrooke survey plan, and the 
Timberbrooke Unit 2 survey plan.
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Entering record data into the cadastral fabric

Before you create a new parcel in the Timberbrooke survey 
plan, you first need to set the record units you will be 
working with, as well as some other record information:
1. Right-click the Timberbrooke plan in the Parcel Explorer 
window and click Properties.

 
The Plan Properties dialog appears.
2. Click the Record Format tab. Under this tab, you can 
set the record units associated with the selected plan. These 
units will be used when entering parcel data from the plan.
3. Make sure Quadrant Bearing is selected for the 

Direction or Angle Type. 
4. Make sure Degrees Minutes Seconds is selected for the 

Direction and Angle Units.
5. Make sure U.S. Survey Feet is selected for the Distance 

and Length Units.

6. For circular curves, click the Circular Curve Parameters 
drop-down list and select Radius and Arc Length.

7. Click the Circular Curve Direction drop-down list and 
select Tangent.

 
You will now enter some additional record information 
from the Timberbrooke plan:
8. Click on the General tab of the Plan Properties dialog. 

You can enter the legal description of the Timberbrooke 
plan in the Description text box.
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9. Click the Attributes tab.
10. Enter the Survey Company name and the Survey Date. 

You can get this information from the Timberbrooke 
PDF file in your \Cadastral Editor\TutorialData folder 
on your local drive.

12. Click OK on the Plan Properties dialog to apply your 
changes.

To view the default accuracy categories defined for the 
cadastral fabric, open the Accuracies table:
13. Right-click the Parcels sublayer in the Table of 

Contents and click Open Attribute Table
The Parcels attribute table appears.
14. Click the Options button on the attribute table, point to 

Related Tables and click 

11. Enter a plan accuracy of level 2. The record data in the 
Timberbrooke survey plan is accurate to the standard 
deviations defined for accuracy level 2.

SD_1_Accuracy_Parcels: Accuracy. The attribute table 
storing the default Accuracy categories defined on the 
cadastral fabric appears. You can modify the information 
stored in this table to define your own Accuracy categories.
15. Close the Parcel and  Accuracy attribute tables.

Entering parcel data using the parcel traverse

Nearly all the parcels in the Timberbrooke survey plan have 
been entered into the cadastral fabric. You will complete the 
Timberbrooke survey plan and enter in the final parcel:
1. Right-click the Timberbrooke plan in the Parcel 

Explorer, and click New Parcel...

The data frame switches from the open fabric job to 
a new, blank data frame for parcel construction. You 
will essentially enter in the parcel data in its own local 
coordinate space. In most cases, there is no coordinate or 
spatial reference information on a survey plan, there is 
only dimension information. Data entry in the cadastral 
editor is tailored to an environment where only dimensions 
are known, with no coordinates or spatial reference 
information. 
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In parcel construction mode in ArcMap, the docked Parcel 
Properties window has become active. 
2.  In the Parcel Properties window, make sure the 
Timberbrooke plan is selected.

3. Type “07916-041-033” in the empty field next to the 
parcel Name field and push <Enter> on your keyboard. 
This is the parcel PIN.

 
4. Click on the Lines tab of the Parcel Properties window.
An empty parcel traverse grid appears. You may need to 
expand the Parcel Properties window to see the full grid.

5. Click on the Bearing field to enter the first leg of the 
parcel traverse. Enter a bearing of “N89-52-06W”. Push 
<Enter> to enter a Distance of “82” feet.

6. Push <Enter> on your keyboard to display the first 
traverse leg in the construction data frame.

You do not need to populate the From and to fields as they 
are populated automatically.

7. Enter in the dimension data for the second parcel 
traverse leg: Enter a bearing of “N00-13-00E” and a 
distance of “72.26” feet. Push <Enter>.
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8. Enter in the circular curve dimension data for the third 
leg of the parcel traverse: Enter a bearing of “N00-13-
00E”, a radius of “25” feet and an arclength of “39.22” 
feet. Push <Enter>.

9. Enter in dimension data for the fourth leg of the parcel 
traverse: Enter a bearing of “S89-53-24W” and a 
distance of “57.05” feet. Push <Enter>.

10. Enter in the fifth and final leg of the traverse to close 
the parcel. Enter a bearing of “S00-13-00W” and a 
distance of 97.25*” feet. Enter an asterix “*” character 
next to the “97.25” to indicate that this is the final leg of 
the traverse. Push <Enter>.

Once you close the parcel traverse back on its starting point, 
misclosure information for the parcel is displayed at the 
bottom of the Parcel Properties window. The misclosure is 
the difference between the starting point of the first traverse 
leg and the ending point of the last traverse leg. The parcel 
misclosure should be as small as possible. The misclosure 
for the parcel you just entered is 0.005 feet, which is within 
acceptable limits. 

Large misclosures indicate either a data entry error, or a 
problem with the survey data.
11. Click Keep changes to parcel data on the Parcel 

Construction toolbar to save your parcel traverse.

The data frame switches back to the active parcels in your 
fabric job and the newly created parcel is listed as an 
unjoined parcel in the Parcel Explorer.
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New parcels reside in unjoined space in an open fabric job. 
Remember, you created your new parcel with no knowledge 
of coordinates, or of a spatial reference. Your parcel has no 
knowledge of where it fits in the cadastral fabric. For your 
new parcel to become part of the cadastral fabric it has to be 
“fitted” or joined into the cadastral fabric.
12. Select the unjoined parcel and click on the Properties 

tab of the Parcel Details dockable window
Notice that the Accuracy of the new parcel is level 2. New 
parcels inherit the accuracy of the plan in which they are 
created, unless another accuracy level is specified.

Joining a parcel to the cadastral fabric

You will now join your new parcel “07916-041-033” to the 
cadastral fabric:
1.  With the fabric job still open, click the View menu, 

point to Bookmarks and click Join Timberbrooke Parcel 
to zoom into the area where you will be joining the 
parcel.

2. Right-click the unjoined parcel “07916-041-033” and 
click Join.

The unjoined parcel appears as a floating geometry in your 
data extent, and the Join Parcel dialog appears. If necessary, 
drag the parcel to a position where join lines can be easily 
constructed between parcel corners.
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5. Join the top right corner.

3. To establish your first join line, click on the bottom 
right corner of the unjoined parcel and then click on its 
corresponding corner in the cadastral fabric.

4. Join the bottom left corner.
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7. Click the Cadastral Editor menu on the Cadastral Editor 
toolbar and click Finish Job.

The fabric job changes are posted back to the cadastral 
fabric.
8. Click the Editor menu on the Editor toolbar and click 

Save Edits to save the changes to the database to 
complete Exercise 3.

Once you have established three join lines, residuals will 
appear in the Join Parcel dialog. A scale and rotation is also 
displayed.

Join residuals are an indication of how well the unjoined 
parcel fits with the surrounding cadastral fabric parcels. The 
residuals are derived from a difference in measurements 
between the joining parcel’s boundaries and the adjacent 
cadastral fabric parcel boundaries. Large residuals are an 
indication of either an inaccurate cadastral fabric, or of 
problems in the unjoined parcel data. In this case, the join 
residuals are small and acceptable.
6. Click OK on the Join Parcel dialog to join parcel 

“07916-041-033” to the fabric job.
The data frame will refresh to display your new parcel as 
one of the active parcels in the fabric job.
To update the cadastral fabric with your changes, the final 
step is to post the fabric job back to cadastral fabric:
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Exercise 4 : Working with parcel construction tools

In the previous exercise, you learnt how to add a new 
parcel to the cadastral fabric using the parcel traverse. In 
this exercise, you will learn how to create a group of new 
parcels using existing parcel geometry as a template. Using 
parcel construction tools, you will split a parcel block into 
smaller, subdivided parcels. Once again you will edit your 
parcels in a fabric job.

Using parcel construction tools to subdivide an 
existing parcel block

For this exercise, you will re-open the fabric job you 
worked with in the previous exercise. You do not need to 
re-select and extract parcels out to a fabric job every time 
you want to edit the cadastral fabric. If you want to work 
with the same set of parcels already added to a previous 
job, you can just re-open the existing fabric job from the 
Job Book.
1. If ArcMap is not open, re-open the application and load 

the AlachuaCounty map document.
2.  Make sure your map is zoomed out to the correct 

extent. (View -> Bookmarks -> Timberbrooke).
3. Start an edit session. (Editor -> Start Editing.)
4. Click the Fabric Editing menu and click Job Book... to 

open the fabric job book.
 

The dockable Job Book window appears on the screen. 
5. Resize the Job Book window, if necessary. In the list 

of fabric jobs, you should see the single fabric job you 
worked on in Exercise 3.

You will re-open this fabric job to continue with your parcel 
edits.
6. Select the fabric job in the Job Book window and click 

Open. You can also double-click on the selected fabric 
job to open it.

The parcels in the selected fabric job are extracted again and 
re-opened in the fabric job.
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7. Close the Job Book.

8. Click on the Select Cadastral Features tool  and 
click on the large, unsubdivided parcel block in the 
active fabric job. You can also select parcel “07916-
041-022” in the Parcel Explorer.

9. Right-click on the selected parcel and click New from 
parent... 

The selected parcel is opened in the parcel construction 
environment.

You will now use the Breakline tool to split the parcel block 
into its subdivided parcels:
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10. Right-click on the top-most line of the parcel and click 
Breakline...

Tip: If you lose focus of the parcel construction tool cursor, click the 
Construction Tool            button on the Parcel Construction toolbar to 
switch back to the parcel construction tool cursor.

11. On the Breakline dialog, click in the first empty line 
in the Break at distance column and enter “54.03” to 
create your first construction point. Click enter.

12. Enter “79.00” on the second line to create your second 
construction point.

13. Enter “79.00” for your third and final construction point 
for the line.

14. Click OK. All three construction points are created on 
the parcel line.

15. Now right-click the bottom-most parcel line and click 
Breakline...
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You will now add a construction point on the left-most line 
of the parcel block:
19. Right-click on the left-most line of the parcel block and 

click Breakline.

The construction points on the bottom line are all at an 
equal distance of 79.00 feet.
16. Click the Switch button to switch the direction of the 

breakline. 
17. On the first line, enter “79” and then a space and the 

number “3”. Push Enter on your keyboard. 

This is a quick method of adding equally spaced 
construction points in succession on a parcel line.

18. Click OK to close the Breakline dialog. 
The three new construction points are added on the 
bottom-most parcel line.

20.  On the Breakline dialog enter “100”. The breakline 
should be going from bottom to top).
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21. Click OK to create the construction point.
Your parcel block should now have the following 
construction points:

You will now add a construction line between the 
construction points on the left and right parcel lines:
22. In the construction line grid, click in the From field of 
the first empty grid line.

23. Click on the construction point on the left parcel line 
and then click on the construction point on the right 
parcel line to construct a line in the middle of the parcel 
block.

The construction line’s parameters are populated in the 
construction grid.

24. Right-click on the line you have just added and click 
Breakline... to add construction points to this line .

25. In the Breakline dialog, enter “79 3” to enter three 
equally spaced construction points at 79 feet apart. 
Click OK.
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Your parcel should now have the following construction 
points:

You will now construct vertical lines between the 
construction points to split the parcel block into smaller, 
subdivided parcels.
26. In the construction line grid, click in the From field of 

the first empty line.
27. Click on construction points 1 and 8, 2 and 9, 3 and 10 

to add three lines to the top half of the parcel block.

28. Click on construction points 8 and 6, 9 and 5, 10 and 4 
to complete the subdivision of the parcel block.

29. Click the Build Parcel  button on the Parcel 
Construction toolbar to build parcels from the newly 
added construction lines and points.

The new parcels are generated and the Parcel Details 
window displays the properties of the selected parcel in the 
parcel group.
30. Make sure that Timberbrooke is selected in the plan 

drop down list as you are adding these new, subdivided 
parcels to the Timberbrooke plan.

You can now enter in a parcel PIN and various other parcel 
attribute information on the Parcel Properties tab. You can 
also select parcels in the parcel group and change their line 
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attributes as well. You may need to edit the line dimensions 
generated (inversed) from the construction lines if they do 
not match the dimensions on the survey record.
In the case of these grouped parcels, some of the 
dimensions generated from the construction line work 
are slightly different from the record. For the purposes of 
the tutorial, you do not have to go through and edit every 
incorrect dimension for each parcel. In reality however, it 
is highly recommended that you do so if you want to obtain 
realistic results from the Least Squares Adjustment.
You can also accept the default parcel names. You do 
not need to set the individual accuracy level of each new 
parcel as the parcels will inherit the accuracy level of the 
Timberbrooke survey plan.
31. Using the Select Cadastral Features tool, select any one 

of the newly generated parcels to view its properties.
The parcel Properties window refreshes to show the 
attributes of the newly selected parcel. You can click on the 
Lines tab to view and edit the line dimensions.

You are now going to save the newly generated parcels:

32. Click Keep changes to parcel data  on the Parcel 
Construction toolbar to save the parcels to the fabric 
job.

Notice that you do not need to join these parcels to the 
fabric job. Since the parcels were created from the geometry 
of an existing job parcel, the parcels are already spatially 
aware of where they fit in the cadastral fabric.
The new parcels are now listed under the Timberbrooke 
plan node in the Parcel Explorer.
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1. Right-click in empty space in the Parcel Explorer and 
click View Historic Parcels.

Viewing historic parcels

When you replaced the existing parcel block in the 
Timberbrooke plan with new, subdivided parcels, the 
parcel became a historic parcel. The parcel block was 
automatically flagged as historic when you clicked the 
“New from parent...” command and saved your new, 
subdivided parcels to the fabric job. 

The parcel explorer refreshes to display historic parcels. A 
historic icon  is displayed next to parcel 07916-041-022.

2. Select the historic parcel in the Parcel Explorer.
The historic parcel block is also selected on the map.
3. Click the Cadastral Editor menu and click Finish Job to 

post your changes back to the cadastral fabric.
4. Click the Editor menu and click Save Edits to save your 

changes and complete Exercise 4.
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Exercise 5 : Appending groups of parcels to the cadastral fabric
So far, you have seen how to add new parcel data to 
a cadastral fabric using the parcel traverse and parcel 
construction tools. You can also append groups of parcels to 
your cadastral fabric in the form of XML files. This would 
be the equivalent of a digital submission of parcels. In this 
exercise you will append a subdivision of parcels from the 
Edgewood survey plan.
1. To view the Edgewood survey plan, navigate to your 

\cadastral editor\TutorialData folder in windows 
explorer. Open EdgewoodPhase1.pdf

Creating a custom fabric job

1. If ArcMap is not already open, open the application and 
load the AlachuaCounty map document.

2. Click the View menu, point to Bookmarks and click 
EdgewoodAppend to zoom the Edgewood survey plan 

You will create a custom fabric job to append the Edgewood 
Phase 1 plan parcels:
3. Click the Editor menu and click Start Editing.
4. Click the Cadastral Editor menu and click Create Job...

The custom fabric job dialog appears on the screen.
5. In the empty field next to Name, type 

EdgewoodAppend as the job title.
6. Type an operator name in the empty field next to 

Owner.

In a custom fabric job, you can specify the parcels you 
want to edit. Edit parcels are locked and this is relevant on 
a multi-user, SDE environment. Locked parcels cannot be 
edited by overlapping jobs.
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7. Click the Select  Cadastral Features tool on 
the Fabric Editing toolbar and select the large, 
unsubdivided parcel on your map extent.

8. Click the Add button next to the Edit Job Parcels list to 
add the selected parcel as an edit parcel to the custom 
fabric job.

The parcel name appears in the Edit Job Parcels list and 
is displayed in red on the map. For joining purposes, the 
immediate, surrounding neighboring parcels are added as 
additional job parcels to the fabric job. These parcels are 
displayed in blue and their parcel names are added to the 
list of job parcels.

Neighboring parcels are added by default to a custom fabric 
job. You can add additional surrounding parcels using a 
radius buffer, or by manually selecting parcels.
9. Click the Parcels within option and enter a radius of 

100 feet.
10. Select U.S Survey Feet from the units drop down list.

11. Click the Get button.
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A radius buffer line is displayed on the map and all parcels 
intersecting this line are added as job parcels to the fabric 
job, and displayed in blue.

12. Leave the Include parcels to fill gaps in the selection 
and Open job when I click OK options checked, and 
click OK to open the fabric job.

The parcels are extracted out into a fabric job. The locked 
edit parcel is displayed with a locked icon  in the Parcel 
Explorer.

Flagging parcels as historic

Before you append the Edgewood Phase 1 subdivision of 
parcels to the fabric job, you will mark the existing parcel 
block as historic.
1. With the fabric job still open, right-click the locked 

parcel under the Edgewood plan node and click Historic 
to turn on the historic flag for the parcel.

2. Right-click in empty space in the Parcel Explorer and 
click View Historic Parcels.

The locked parcel icon changes to the historic parcel icon.
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3. Turn the display of historic parcels off. (Right-click 
in empty space in the Parcel Explorer and click View 
Historic Parcels)

The historic parcel block is no longer visible on the map.

Appending parcels to a fabric job

1. With the fabric job still open, click the Cadastral Editor 
menu and click Append file...

2. In the Open dialog, navigate to your \cadastral editor\
TutorialData\ folder on your local drive and select the 
EdgewoodPhase1.xml file.

3. Click Open.
The Edgewood Phase 1 plan parcels are loaded as unjoined 
parcels in the fabric job.

Joining a parcel group to the cadastral fabric

You will now join the Edgewood Phase 1 unjoined parcel 
group:
1. With the fabric job still open, zoom closer into the join 

area.
2. Right-click any of the unjoined parcels in the 

Edgewood Phase 1 plan and click Join.
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The geometry of the parcel group is floated on the map 
extent. 
3. Click anywhere within the parcel group geometry 

and drag the geometry to position the unjoined parcel 
corners for joining.

4. Snap on the top left corner of the parcel group and snap 
on its corresponding corner in the cadastral fabric to 
create the join line.

5. Join the top right corner.

6. Now join the three bottom left corners of the parcel 
group

7. Join the bottom right corners of the parcel group.
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8. Click Auto Join on the Join dialog to pick all remaining 
join lines

The residuals vary, some are small and some are a little 
bigger. This is because the parcel data you have just 
appended to the fabric job is more accurate than the 
surrounding parcel data.
9. Click OK on the Join Parcel dialog to accept the join.
The appended subdivision parcels are now active parcels of 
the open fabric job.
10. Select one of the parcels you have just appended and 
confirm that the parcel’s accuracy is level 2 in the Parcel 
Details window

11. Select one of the parcels surrounding your appended 
parcels and confirm that its accuracy level is 6 in the 
Parcel Details window.

The parcels you appended in the Edgewood Phase 1 plan 
are more accurate than the surrounding parcels, hence the 
varying join residuals. Even though it may seem that your 
more accurate Edgewood Phase 1 parcels were joined and 
“fitted” into the less accurate surrounding parcels, running a 
Least Squares Adjustment on this fabric job would result 
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in the less accurate parcels adjusting around the more 
accurate parcels. The more accurate parcels will maintain 
their survey integrity through the Least Squares Adjustment.
Post your job changes back to the cadastral fabric to 
complete Exercise 5:
12. Click the Cadastral Editor menu and click Finish job.
13. Click the Editor menu and click Save Edits to save your 

changes.
14. Stop the Edit Session (Editor -> Stop editing).
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Exercise 6 : Adding control points to your cadastral fabric

In a Least Squares Adjustment of the cadastral fabric, 
control points are used as a basis for improving the 
spatial accuracy of all other parcel points in the network. 
Control points are held as fixed points in the Least Squares 
Adjustment and georeference the cadastral fabric. While 
fabric parcels may be accurately defined in relation to each 
other, control points, used in a Least Squares Adjustment, 
accurately coordinate parcels on the surface of the earth. 
In this exercise, you will import control points into the 
cadastral fabric from an existing feature class. Control 
points can also be entered manually in a fabric job. You 
will enter a new control point into the Timberbrooke survey 
plan. 

Importing control points from a feature class into 
the cadastral fabric

1. Open ArcCatalog if it is not already open.
2. Open the connection you created to your tutorial 

data in Exercise 1. Navigate to your cadastral fabric 
(NewFabric) in the ACPA feature dataset.

3. Right-click on the cadastral fabric, point to Import and 
click Control Points.

The Import Control Points wizard will appear.

4. Click the Open File button  and navigate to the 
Control feature class in the ACPA feature dataset. 

5. Select the Control feature class and click Add on the 
Import Control Points dialog. 

6. Do not check the Use shape field for coordinates box.
The control feature class has X, Y, Z coordinate attributes 
and the importer will be using these attribute coordinates. 
If your control point feature class has no X, Y, Z coordinate 
attributes, you can check the Use shape field for coordinates 
box. The importer will then obtain the X, Y, Z coordinates 
from the shape field of the feature class.
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7. Click Next
8. Enter “3.5” feet for the Match point to control tolerance 

value.

The Match point to control tolerance is the tolerance 
used when matching control points to parcel points in the 
cadastral fabric. Control points must be associated with 
parcel points in the cadastral fabric for them to be included 
in the Least-Squares Adjustment of the network. If a 
cadastral fabric is inaccurate, parcel points in the cadastral 
fabric may not match the locations of their control points 
exactly. If this is the case, control points can be linked 
(or associated) to parcel points that lie within a specified 
distance (tolerance) of the control points.
9. Click Next to view the import summary and click 

Finish to import the control points.
10. Open ArcMap and re-open the AlachuaCounty map 

document in your \cadastral editor\ folder.
The control points should now be visible on the map.

If the importer was unable to find fabric points within the specified 
tolerance, the imported control points will not be able to participate 
in a Least Squares Adjustment.  In this case, you can use the manual 
control point link tool          to associate control points to their parcel 
points.

11. Zoom into the Timberbrooke survey plan on the map 
(View -> Bookmarks->Timberbrooke)

If you zoom in a little closer to each of the control points, 
you will notice that the fabric parcel points do not exactly 
match the locations of their control points. This is because 
the control data is more accurate than the parcel data. The 
fabric points do however, all fall within the specified 3.5 
foot tolerance and are associated to their control points. 
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Adding control points manually to the cadastral 
fabric

In addition to importing control points, you can also 
manually add control points to your cadastral fabric. 
You will now manually enter a control point from the 
Timberbrooke survey plan:
1. Click the Editor menu and click Start Editing to start 

and edit session.
You will add a control point to top-right corner of the 
Timberbrooke survey plan parcels. 

2. Click the Select Cadastral Features tool  on the 
Cadastral Editor toolbar and drag a box to select the 
parcels in the area where you will be adding a control 
point.

The grid on the Control dialog is populated with the 
Network point ID (Associated parcel point ID), a default 
control point name and the Easting and Northing values of 
the parcel point. You will re-enter the Control Point Name, 
and the Easting and Northing values of the control point as 
the parcel point coordinates do not match the coordinates of 
the control point.
6. In the Control dialog, click the value field of the 

Control Point Name and enter a name of “Sect39/42”
3. Click the Cadastral Editor menu and click Modify... to 

extract the selected parcels into a fabric job.

3. Zoom to the active parcels in the open fabric job.

4. Click on the Maintain control points  button on the 
Cadastral Editor toolbar.

The control dialog appears on your screen. 
5. Click the New button on the Control dialog and click on 

the top right parcel corner point of the parcel shown in 
the screenshot below.



40

Survey Analyst - Cadastral Editor Tutorial Beta 3

8. Click Update to add the new control point to the control 
points list and to the active fabric job. Close the control 
dialog.

The control point will appear in its correct location on the 
map.

8. Click the Cadastral Editor menu and click Finish 
job to post your changes back to the cadastral fabric. 
Save your edits and stop the edit session to complete 
Exercise 6.

7.  Click the Easting value field and enter a coordinate 
of “2650041.28”. For the northing coordinate, enter 
“258770.54”.
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Exercise 7 : Adjusting your cadastral fabric

Now that you have added control points to the 
Timberbrooke survey plan, you are able to run a Least 
Squares Adjustment on the parcels in this area. Least 
Squares Adjustments are run on the active parcels in an 
open fabric job. The adjusted parcels are then posted back 
to the cadastral fabric. 
The Least Squares Adjustment processes all the parcel 
line measurements together with the control points 
to derive new coordinates for the parcel points. The 
adjustment essentially finds a “ best-fit” for the parcel 
point coordinates, based on the new and existing parcel 
data, the accuracy of the parcel data, and on the control 
points. Control points are treated as fixed points in a fabric 
adjustment and do not shift. 
Since the Least Squares Adjustment derives new 
coordinates for the parcel corner points, parcel boundaries 
will adjust slightly or significantly, depending on how 
accurate the parcel data is in relation to the control points. 
As the cadastral fabric is adjusted, overlying GIS layers 
will fall out of alignment with the parcel base map. In this 
exercise, You will run a GIS Feature Adjustment to bring 
your GIS layers back into alignment with your adjusted 
parcels.

Adding connectivity to a parcel boundary network

Before you run an adjustment on your parcels, you need to 
ensure that there is good connectivity in the network.

1. If ArcMap is not open, restart the application and open 
the AlachuaCounty map document. Start an edit session.

2. Zoom to the Timberbrooke survey plan area. (View -> 
Bookmarks -> Timberbrooke)

3. Click the Cadastral Editor menu and click Job Book to 
open the fabric job book.

You will notice 3 jobs now present in the job book. The first 
job is the automatic job that was created in Exercise 3. The 
second job is the custom, named job you created to append 
the Edgewood Phase 1 survey plan parcels in Exercise 5. 
The third job is the automatic job that was created when you 
entered the control point in exercise 6.  

4.  In the Job book, select the first job you created to open 
the parcels in the Timberbrooke survey plan area. Click 
Open. 
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The Timberbrooke survey plan parcels are re-opened in the 
existing fabric job. Notice that the control points are now  
picked up as part of the fabric job as well, since they are 
associated to parcel points in the fabric job. 
5. Close the job book.
When running an adjustment on a group of parcels in 
a fabric job, you need to ensure that there is sufficient 
connectivity in the parcel boundary network. There is 
already a connection line that connects the western strip of 
parcels to the eastern block of parcels

However, this connection line is not sufficient to run an 
adjustment on a parcel group of this shape and size. More 
connectivity is needed further south. You will now add one 
more connection line to the parcel network in the job.
6. Click the View menu, point to Bookmarks and click 

AddConnectionLine to zoom in closer to the points you 
will connect.

7. Click the Create Connection tool  on the Cadastral 
Editor toolbar.

8. In the Create Connection dialog, click in the empty box 
next to “point 1”.

9. Click on the bottom left corner point of the parcel on 
the right of the empty road space.

The parcel point ID is added to the empty box in the Create 
Connection dialog.
10. Click in the empty box next to “Point 2” and click on 

the bottom right corner point of the parcel on the left of 
the empty road space.

The bearing and distance of the new connection line is 
displayed in the Create Connection dialog.  
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If the bearing and distance of the connection line does not 
match the survey record, you need to edit the dimensions of 
the newly created connection line so that it reflects the sur-
vey record. You will do this now.
11. Click the OK to create the new connection line.
The map will refresh to display your new connection line.
12. Using the Select Cadastral Features tool, right-click the 

parcel to the right of the new connection line and click 
Open.

13. In the parcel edit frame, click the Lines tab of the Parcel 
Details Window.
14. Change the bearing and distance of the parcel’s new 
connection line to “N89-50-47W” and “60 feet”.

15. Click the Keep changes to parcel data button  on 
the Parcel Construction toolbar.

The parcel is saved back to the fabric job. Now do the same 
for the parcel on the left of the new connection line:
16. Open the parcel on the left of the connection line.

17. Change the bearing and distance of the new connection 
line to “S89-40-47E” and “60 feet”.

18. Save the parcel changes back to the fabric job.
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4. Close the Control dialog.
5. For visual purposes, turn on the display of your roads 

and buildings GIS feature classes in the map. This will 
give you an idea of the misalignment between the GIS 
layers and the fabric parcels after the Least Squares 
Adjustment is applied.

6. Click the Cadastral Editor menu and click Adjust.
The Adjust Coordinates dialog appears on the screen. You 
will specify the adjustment tolerances in this dialog before 
you  run the adjustment. Adjustment tolerance values are for 
analysis purposes of the LSA results. Large tolerance values 
should be entered when adjusting an inaccurate network 
where much movement is expected in the data. Small 
tolerances should be used when adjusting an accurate and 
stable network. Any movements exceeding the tolerance 
values will be reported in the adjustment report.
7. For the Distances tolerance, enter a value of 1.5 feet. 

Enter a value of 1 foot for the tolerances for Line points 
and Close points as well. Leave the default of 6000 
seconds for the Bearings tolerance.

Running a Least Squares Adjustment on parcels 
in a Fabric Job

You will now run a Least Squares Adjustment (LSA) on the 
active parcels in your open fabric job. But first, you need to 
examine the control points in the fabric job.
1. Zoom back to the Timberbrooke extent (View -> 

Bookmarks -> Timberbrooke).

2. Click on the Maintain Control Points tool  on the 
Cadastral Editor toolbar.

The Control dialog appears. You will notice that all of the 
control points are active. 
You will now check the fit of your active control points 
with the parcel network in the fabric job.  The control point 
“check fit” residuals are an indication of how well the 
parcel network fits with the control points. Large residuals 
indicate that the parcel network does not fit well with the 
control points, which means that the parcels are inaccurate 
in relation to their control points. These residual values can 
be used as a guideline for setting Check Tolerances in the 
Adjust dialog. Your check tolerances need to be at least as 
large as the “check fit” residuals, as this is the amount the 
parcel points will need to adjust to be coincident with their 
control points.
3. Click the Check Fit button on the Control dialog.
The check fit residuals are displayed in the Control dialog, 
and are just under 1 foot, so your adjustment tolerances 
need to be at least around 1 foot.



45

Survey Analyst - Cadastral Editor Tutorial Beta 3

The Bearings tolerance is the maximum allowable 
difference between the line computed from the new point 
coordinates resulting from the adjustment, and the original 
measured line. The Distance tolerance is the maximum 
allowable difference between the distance computed from 
the new point coordinates resulting from the adjustment, 
and the original measured distance. The Line Points 
tolerance is a check tolerance that flags any line point that 
lies further away from its line than the specified tolerance. 
Line points can fail to lie on their lines due to parcel 
joining. The Close Points tolerance  flags any points that lie 
closer together than the specified tolerance. 
8. Under Force Plan Structure, check the Line points 

tolerance check box. The line points tolerance checks 
for line points that are not lying on the line on which 
they are supposed to lie. Line points that lie within the 
specified tolerance of their lines are forced back onto 
their lines. Checking this tolerance will correct slivers 
that have been created from line points during the 
joining process. Enter a value of 1 foot. 

9. Leave the default values for the remaining options on 
the Adjust Coordinates dialog and click OK to run the 
adjustment.

Make sure you have a temp directory created under your c:\ drive. A 
c:\temp directory is required to store the adjustment results file.

The adjustment completes successfully and displays an 
overview of the adjustment results. The adjustment finds 
no close points and no line point errors. The report also 
displays the point with the largest change in its coordinates.

Under the Lines Report, recomputed lines that exceeded the 
specified tolerance for Bearings and Distances are reported. 
Six recomputed lines exceeded your bearing and distance 
tolerances, however none of these lines had to be 
significantly recomputed to fit into the solution.
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To view the complete adjustment report, click on the 
Results File button on the Least Squares Adjustment 
Summary dialog.

The largest line change is 1.778 feet, which is slightly 
above your distance tolerance of 1.5 feet.

You can select and zoom to the parcels containing the lines 
that exceeded your line tolerances:
10. Click on any of the line errors listed in the adjustment 

report.
11. Click the Select Parcels button.
The parcel containing the line error is selected on the map 
and in the Parcel Explorer.

You can also zoom and pan to the parcel by clicking on the 
drop-down arrow next to the Select Parcels button.

12. Click Accept on the Least Squares Adjustment 
Summary dialog to accept the results of the adjustment.

You will notice a slight adjustment in the parcel geometry.
13. Zoom in closer to view the change between adjusted 

parcel lines in the fabric job and the unadjusted parcel 
lines in the cadastral fabric

You will also notice that parcel points are now coincident 
with the location of their associated control points.
14. Zoom back out to the Timberbrooke extent and post 

the job back to the cadastral fabric. (Fabric Editing -> 
Finish Job).

15. Save your edits.
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Adjusting GIS Data using the GIS Feature 
Adjustment 

Now that you have successfully adjusted parcels in your 
cadastral fabric, you will be able to run a GIS Feature 
Adjustment on GIS features in the area of adjustment. In 
this step, you will adjust the roads and buildings feature 
classes in the Timberbrooke survey plan job extent. You 
will also associate and adjust the Timberbrook_Easements 
feature class.
1. With ArcMap still open and the edit session still active, 

right-click the NewFabric layer in the TOC and click 
Feature Adjustment...

The Cadastral Feature Adjustment dialog appears.
2. Check the checkboxes for both the buildings and Roads 

feature classes. 

3. Click the Adjust button on the Cadastral Feature 
Adjustment dialog to run the feature adjustment.

Once the feature adjustment completes you will notice 
a slight shift in both the roads and the buildings feature 
classes as they re-align with the adjusted parcels.
You will now associate the Timberbrook_Easements feature 
class to the cadastral fabric and adjust the easement data.
4. Add the Timberbrook_Easements feature class (located 

in the GRU feature dataset) to the map.
5. Right-click the NewFabric layer in the TOC and click 

Feature Adjustment.
You will now notice that the Adjusted Date for both the 
roads and buildings feature class has been set to the date 
and time of the last Least Squares Adjustment run on 
the cadastral fabric. This date and time is known as the 
adjustment level.

6. Click the Add... button on the Feature Adjustment 
dialog.

7. Navigate to, and select the Timberbrook_Easements 
feature class in the AlachuaCounty\GRU feature 
dataset. Click Add.
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The Timberbrook_Easements feature class is added to the 
Cadastral Feature Adjustment dialog and its adjusted date is 
set to “Not Yet Adjusted”.

8. Select all three feature classes to participate in the 
adjustment.

9. Click the Adjust button to rerun the feature adjustment.
You will notice that only the Timberbrook_Easements 
feature class is adjusted. That is because the roads 
and buildings feature classes are already at the most 
current adjustment level and are not re-adjusted with 
this adjustment. If you re-open the Cadastral Feature 
Adjustment dialog, you will notice that the Adjusted Date 
for the Timberbrook_Easements feature class is now the 
same as the Adjusted Date for the roads and buildings 
feature classes.
10. Save your edits and close ArcMap to complete the 

tutorial.


